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Network planning involves designing systems for moving goods from suppliers to demand points 
or selecting service facilities in the public sector. Key decisions include the number, location, size, 
and equipment of facilities, as well as whether to divest, relocate, or downsize them.

Classification of location problems

Location problems can be classified with respect to a number of criterias. For example,

Time 
horizon

Single-period
(make decision at the beginning)

Multi-period
(make decision in sequence)

Facility 
typology

Single-type 
(e.g. only RDCs)

Multi-type 
(both CDCs & RDCs)

RDCs = regional distribution centres
CDCs = central distribution centres

Material 
flows

Single-commodity
(homogeneous items)

Multi-commodity
(several items)

Dominant 
material 

flows

Single-echelon
(inbound or outbound)

Multiple-echelon
(inbound and outbound)
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A Single-Echelon, Single-Commodity (SESC) Location Model is a logistics optimisation model used to 
select optimal facility locations (e.g., warehouses or distribution centers) in a single-tiered distribution 
network, handling only a single type of product (commodity). This model simultaneously decides on 
facility locations and commodity distribution routes to minimise overall logistics and operating costs

Example. A petroleum company needs to locate fuel depots to serve gas stations across a region

Echelon:   Depot to station (one-tier system)

Commodity:  A single type of fuel (e.g., gasoline)

Goal:   Minimise operational costs and travel distance from depots to stations
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• Facilities are homogeneous (e.g., all regional warehouses).

• Only inbound or outbound flow is significant, not both (single-echelon).

• All flows are homogeneous (single-commodity).

• Transportation cost is linear or piecewise linear and increases at a decreasing rate as output or activity increases.

• Operating cost is piecewise linear and increases at a decreasing rate as output or activity increases (or constant).
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The single-echelon, single-commodity network typically consists of two node types:

Some other applications

Facility Nodes 
(Potential Locations)

Customer Nodes 
(Demand Points)

Candidate locations for warehouses 
or distribution centers.

Locations requiring 
product delivery.

• Warehouse and distribution center location planning. 

• Emergency response logistics (disaster relief centers).

• Public service facility location (fire stations, healthcare clinics). 

• Retail outlet placement decisions.
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Decision Variables

• Facility Opening Decisions (𝑧𝑗): Binary variables indicating if facility 𝑗 is opened (𝑧𝑗  =  1) or not (𝑧𝑗  =  0). 

• Commodity Flow Decisions (𝑦𝑗𝑘): Quantity of the commodity shipped from facility 𝑗 to customer k.

Parameters

• Demand at customer 𝑘: 𝐷𝑘

• Capacity of facility 𝑗: 𝐾𝑗

• Fixed cost of opening facility 𝑗: 𝑓𝑗

• Transportation cost per unit from facility 𝑗 to customer 𝑘: 𝑐𝑗𝑘
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The objective function is to minimise total costs (facility opening + transportation)

min ෍

𝑗∈𝑉1

෍

𝑘∈𝑉2

𝑐𝑗𝑘𝑦𝑗𝑘 + ෍

𝑗∈𝑉1

𝑓𝑗𝑧𝑗

Subject to constraints:

• Demand satisfaction constraints

• Facility capacity constraints

• Binary capacity constraints

• Non-negativity constraints

෍

𝑗∈𝑉1

𝑦𝑗𝑘 = 𝐷𝑘 , ∀𝑘 ∈ 𝑉2

෍

𝑘∈𝑉2

𝑦𝑗𝑘 ≤ 𝐾𝑗𝑧𝑗 , ∀𝑗 ∈ 𝑉1

𝑧𝑗 ∈ 0, 1 , ∀𝑗 ∈ 𝑉1

𝑦𝑗𝑘 ≥ 0, ∀𝑗 ∈ 𝑉1, 𝑘 ∈ 𝑉2



4.1 CONSTANT COST – EXAMPLE 

9

Example 1.  A retailer must determine optimal warehouse locations to distribute a single commodity 
(e.g., bottled water) to three customer zones. Two warehouse locations are available (W1 and W2).

Warehouse Capacity (units) Fixed cost ($)

W1 300 1,000

W2 250 800

Customer Zone Demand (units)

Zone A 150

Zone B 120

Zone C 80

Warehouse Zone A Zone B Zone C

W1 4 3 5

W2 2 4 3

Table 1. Warehouse data
Table 2. Customer demands

Table 3. Transportation cost from warehouse to customer zone ($/unit)
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Sets and indices

• Set of warehouses:  𝑉1 = {1, 2},  indexed by 𝑗

• Set of customer zones: 𝑉2 = {𝐴, 𝐵, 𝐶},  indexed by 𝑘

Decision Variables

• Facility opening decisions variables (𝑧𝑗) indicating if warehouse 𝑗 is opened (𝑧𝑗  =  1) or not (𝑧𝑗  =  0). 

• Commodity Flow Decisions (𝑦𝑗𝑘): Quantity shipped from warehouse 𝑗 to customer k.

Parameters

• Demand at customer zone 𝑘: 𝐷𝑘

• Capacity of warehouse 𝑗: 𝐾𝑗

• Fixed cost of opening warehouse 𝑗: 𝑓𝑗

• Transportation cost per unit from warehouse 𝑗 to customer zone 𝑘: 𝑐𝑗𝑘
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Objective function

Constraints

min 𝑍 = min ෍

𝑗∈𝑉1

෍

𝑘∈𝑉2

𝑐𝑗𝑘𝑦𝑗𝑘 + ෍

𝑗∈𝑉1

𝑓𝑗𝑧𝑗

Explicitly, for this scenario: min 𝑍 = 4𝑦1𝐴 + 3𝑦1𝐵 + 5𝑦1𝐶 + 2𝑦2𝐴 + 4𝑦2𝐵 + 3𝑦2𝐶 + 1000𝑧1 + 800𝑧2

• Demand satisfaction constraints (each customer zone’s demand must be satisfied)

• Warehouse capacity constraints

• Binary capacity constraints

• Non-negativity constraints

𝑧𝑗 ∈ 0, 1 , ∀𝑗 ∈ 𝑉1

𝑦𝑗𝑘 ≥ 0, ∀𝑗 ∈ 𝑉1, 𝑘 ∈ 𝑉2

෍

𝑗∈𝑉1

𝑦𝑗𝑘 = 𝑦1𝑘 + 𝑦2𝑘 = 𝐷𝑘

𝑦1𝐴 + 𝑦2𝐴 = 150

𝑦1𝐵 + 𝑦2𝐵 = 120

𝑦1𝐶 + 𝑦2𝐶 = 80

෍

𝑘∈𝑉2

𝑦𝑗𝑘 ≤ 𝐾𝑗𝑧𝑗

𝑦1𝐴 + 𝑦1𝐵 + 𝑦1𝐶 ≤ 300𝑧1

𝑦2𝐴 + 𝑦2𝐵 + 𝑦2𝐶 ≤ 250𝑧2
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Case 3: Both Warehouses Open 
(𝒛𝟏 = 𝟏, 𝒛𝟐 = 𝟏)

Note. SESC model is commonly solved using Mixed-Integer Linear Programming (MILP), because binary decision 
variables are not suitable for Lagrangian method. Also, manual calculation will become infeasible as the number of 
variables and the complexity of the constraints and cost structure increase. 

There are 3 possible combinations (excluding 𝑧1 = 𝑧2 = 0): (0, 1),  (1, 0),  (1, 1)

Total Capacity = ෍

𝑗∈𝑉1

𝐾𝑗𝑧𝑗 = 300𝑧1 + 250𝑧2

Total Demand = ෍

𝑘∈𝑉2

𝐷𝑘 = 150 + 120 + 80 = 350

For all possible combinations, the total capacity need to at least meet the total demand.

Case 1: Warehouse 2 Open 
(𝒛𝟏 = 𝟎, 𝒛𝟐 = 𝟏)

Total Capacity = 250 < 350

Infeasible (skip this case)

Case 2: Warehouse 1 Open 
(𝒛𝟏 = 𝟏, 𝒛𝟐 = 𝟎)

Total Capacity = 300 < 350

Infeasible (skip this case)

Total Capacity = 550 > 350

Feasible (continue)

First, let’s check all the possible configuration of (𝑧1, 𝑧2).
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Consider the case where both warehouses open (𝑧1 = 1, 𝑧2 = 1), let’s assign the lowest-cost routes based on 
the information given in Table 2 and Table 3.

→  𝑦2𝐴= 150

Warehouse Zone A Zone B Zone C

W1 4 3 5

W2 2 4 3

Table 3. Transportation cost from warehouse to customer zone ($/unit) Customer Zone Demand (units)

Zone A 150

Zone B 120

Zone C 80

Table 2. Customer demands

Zone B: The cheapest route is from W1; therefore, assign All of B’s to W1 

Zone A: The cheapest route is from W2; therefore, assign All of A’s to W2 

Zone C: The cheapest route is from W2; therefore, assign All of C’s to W2 →  𝑦2𝐶 = 80

If the problem itself is fairly simple (≤ 3 facilities and ≤ 3 customers), we can evaluate the objective function for each 
possible combinations and pick the lowest Z. Otherwise, computer programming is required.

→  𝑦1𝐵= 120

Verify the capacity used: W1 = 120 < 300  and  W2 = 150 + 80 = 230 < 250

Objective Function: 𝑍 = 2 150 + 3 80 + 3 120 + 1000 + 800 = 2700
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Alternatively, we can use Excel Solver tool, which 
allows us to alter decision variables in a spreadsheet 
in order to achieve a desired objective function.

How to begin?

1. Setup costs, capacities and demand input table

2. Setup decision variables table for 𝑦𝑗𝑘 and 𝑧𝑗

3. Setup constraint tables using Excel formula

i. Capacity constraints can be written as 

    𝐾𝑗𝑧𝑗 − σ𝑘 𝑦𝑗𝑘 ≥ 0

ii. Demand constraints can be written

    𝐷𝑘 − σ𝑗 𝑦𝑗𝑘 = 0

4. Setup objective function

5. Initialise decision variables and cost as zero.

Input - Costs, Capacities, Demand
Zone A Zone B Zone C Cost Capacity

W1 4 3 5 1000 300
W2 2 4 3 800 250
Demand 150 120 80

Decision Variables y_jk
Zone A Zone B Zone C z_j

W1 0 0 0 0
W2 0 0 0 0

Constraints
Warehouse Capacity
W1 0
W2 0

Unmet Demand Zone A Zone B Zone C
150 120 80

Objective function

Cost = 0
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How to use Excel Solver tool in Microsoft Excel?

1. File → Options → Add-ins 

    → Manage Excel Add-ins → Go

   → Tick on Solver Add-in → OK

2. From Data tab, check under Analyze → Solver

3. On Solver Parameters window,

→ Set Objective: select a cell and set a goal

→ Add constraints

→ Solve

Check your Excel Solver solution with our solution.
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Input - Costs, Capacities, Demand
Zone A Zone B Zone C Cost Capacity

W1 4 3 5 1000 300
W2 2 4 3 800 250
Demand 150 120 80

Decision Variables y_jk
Zone A Zone B Zone C z_j

W1 0 120 0 1
W2 150 0 80 1

Constraints
Warehouse Capacity
W1 180
W2 20

Unmet Demand Zone A Zone B Zone C
0 0 0

Objective function

Cost = 2700

Interpret the results

• Both warehouses should be opened.

• W1 should ship 120 units to Zone B.

• W2 should ship 150 units to Zone A 

and 80 units to Zone C.

• There are 180 units of capacity left in W1.

• There are 20 units of capacity left in W2.

• The minimum total cost is $2,700



4.2 SINGLE-SOURCING CONDITION

17

Mathematically

The single-sourcing condition in a SESC facility location model refers to a constraint that enforces each 
customer (or demand point) to be served by exactly one facility (e.g., warehouse, depot, plant) — not split 
across multiple facilities.

In standard SESC models, the shipment variable 𝑦𝑗𝑘 represents the amount of product shipped from facility 𝑗 
to customer 𝑘. Under single-sourcing, each customer 𝑘 must receive its entire demand from only one facility.

1. Demand assigned to one source only: ෍

𝑗

𝑥𝑗𝑘 = 1, ∀𝑘

Let 𝑥𝑗𝑘 ∈ {0,1}:  binary assignment – if facility j serves customer k, 0 otherwise.

2. Flow consistency (linking constraint): 𝑦𝑗𝑘 = 𝐷𝑘 ⋅ 𝑥𝑗𝑘,  ∀𝑗, 𝑘

Shipments match full demand only if facility j is assigned to serve customer k.
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Example 2. An emergency response organisation selects from four potential distribution facilities (F1, F2, 
F3, F4) to supply drinking water to six affected areas (A, B, C, D, E, F) following a natural disaster. Each 
area’s demand must be satisfied entirely from exactly one distribution facility.

Facility Capacity (units) Fixed Cost ($)

F1 400 2000

F2 350 1800

F3 450 2200

F4 500 2500

Table 1. Facility information

Table 2. Affected area demand

Facility A B C D E F

F1 3 4 5 4 3 4

F2 4 3 2 5 4 3

F3 3 2 5 4 3 5

F4 5 3 4 2 3 4

Affected Area A B C D E F
Demand (units) 150 100 180 150 120 100

Table 3. Transportation cost ($/unit)
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Sets and indices • Set of facilities:   𝐽 = {1, 2, 3, 4},   indexed by 𝑗

• Set of customer zones: 𝐾 = {𝐴, 𝐵, 𝐶, 𝐷, 𝐸, 𝐹},  indexed by 𝑘

Decision Variables

• Commodity Flow Decisions (𝑦𝑗𝑘): Quantity shipped from warehouse 𝑗 to customer k.

Parameters

• Demand at customer zone 𝑘: 𝐷𝑘

• Transportation cost per unit from facility 𝑗 to area 𝑘: 𝑐𝑗𝑘

• Capacity of facility 𝑗: 𝐾𝑗

• Fixed cost of opening warehouse 𝑗: 𝑓𝑗

• Facility opening decisions variables (𝑧𝑗): 𝑧𝑗 = ቊ
1, if facility 𝑗 is opened
0, otherwise

• Assignment decision (single-sourcing) (𝑥𝑗𝑘): 𝑥𝑗𝑘 = ቊ
1, if area k is supplied by facility j
0, otherwise
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Objective function

Constraints

min 𝑍 = min ෍

𝑗∈𝐽

෍

𝑘∈𝐾

𝑐𝑗𝑘𝑦𝑗𝑘 + ෍

𝑗∈𝐽

𝑓𝑗𝑧𝑗

• Demand satisfaction constraints (single-sourcing)

• Facility capacity constraints

• Binary capacity constraints

• Non-negativity constraints

𝑧𝑗 , 𝑥𝑗𝑘 ∈ 0, 1 , ∀𝑗 ∈ 𝐽, 𝑘 ∈ 𝐾

𝑦𝑗𝑘 ≥ 0, ∀𝑗 ∈ 𝐽, 𝑘 ∈ 𝐾

෍

𝑘∈𝐾

𝑦𝑗𝑘 ≤ 𝐾𝑗𝑧𝑗 ,  ∀𝑗 ∈ 𝐽

෍

𝑗∈𝐽

𝑥𝑗𝑘 = 1, ∀𝑘 ∈ 𝐾

𝑦𝑗𝑘 = 𝐷𝑘 ⋅ 𝑥𝑗𝑘 ,  ∀𝑗 ∈ 𝐽, 𝑘 ∈ 𝐾

• Facility opening constraints 𝑥𝑗𝑘 ≤ 𝑧𝑗 , ∀𝑗 ∈ 𝐽, 𝑘 ∈ 𝐾
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Input - Costs, Capacities, Demand
A B C D E F Cost Capacity

F1 3 4 5 4 3 4 2000 400
F2 4 3 2 5 4 3 1800 350
F3 3 2 5 4 3 5 2200 450
F4 5 3 4 2 3 4 2500 500
Demand 150 100 180 150 120 100

Decision Variables
y_jk A B C D E F z_j
F1 0 0 0 0 0 0 0
F2 150 0 180 0 0 0 1
F3 0 0 0 0 0 0 0
F4 0 100 0 150 120 100 1

x_jk A B C D E F
F1 0 0 0 0 0 0
F2 1 0 1 0 0 0
F3 0 0 0 0 0 0
F4 0 1 0 1 1 1
Constraints
Facility Capacity Assignment 
F1 0 0 0 0 0 0 0
F2 20 0 1 0 1 1 1
F3 0 0 0 0 0 0 0
F4 30 1 0 1 0 0 0

Demand A B C D E F
F1 0 0 0 0 0 0
F2 0 0 0 0 0 0
F3 0 0 0 0 0 0
F4 0 0 0 0 0 0
sum x_jk 1 1 1 1 1 1

Objective function

Cost = 6620

Interpret the results

• F2 and F4 should be opened.

• F2 should ship to Area A and C.

• F4 should ship to Area B, D, E, and F

• There are 20 units of capacity left in F2.

• There are 30 units of capacity left in F4.

• The minimum total cost is $6,600
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The operating cost of a potential facility is usually a piecewise linear function. In the simplest case, 
there are only two piecewise lines. The operating costs of potential facility 𝑖, 𝐶(𝑑), for a particular 
demand 𝑑 are characterised by fixed costs (𝑓𝑖

′ and 𝑓𝑖
′′) and marginal costs (𝑔𝑖

′ and 𝑔𝑖
′′).  Then,

𝑓𝑖
′

𝑓𝑖
′′

𝑑𝑏 𝑑

𝐶(𝑑) = ቐ
𝑓𝑖

′ + 𝑔𝑖
′ ⋅ 𝑑 if 0 < 𝑑 ≤ 𝑑𝑏,

𝑓𝑖
′′ + 𝑔𝑖

′′ ⋅ 𝑑 if 𝑑 > 𝑑𝑏, 

0  if 𝑑 = 0.

𝐶 𝑑
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Example 3. Historical demand and costs data of a firm are given as follows:

𝒅 1000 2500 3500 6000 8000 9000 9500 12000 13500 15000 16000 18000

𝑪 17579 56350 62208 76403 85491 90237 96251 109429 10755 122432 116816 124736

Use the above data to model the relationship between demand and cost as a piecewise linear function with a 
known breakpoint at 𝑑 = 𝑑𝑏 = 3500. Explain the results and formulate the optimisation model.

𝐶(𝑑) = ቐ
2252.4 + 18.483𝑑 if 𝑑 ≤ 3500,
54409.4 + 4.107𝑑 if 𝑑 > 3500,

0 if 𝑑 = 0.

C(d)   1 .    d   22 2. 
 

1    

2    

     

     

     

     

     

     

 1   2           

C(d)    .1  2 d        

 

2    

     

     

     

1     

12    

1     

     1    1    2    

𝐶(𝑑) = ቐ
𝑓𝑖

′ + 𝑔𝑖
′ ⋅ 𝑑 if 0 < 𝑑 ≤ 𝑑𝑏,

𝑓𝑖
′′ + 𝑔𝑖

′′ ⋅ 𝑑 if 𝑑 > 𝑑𝑏, 

0  if 𝑑 = 0.
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A company is considering network design decisions over two planning periods and deciding between 
two warehouse locations (A and B) to serve three market regions (X, Y, and Z). Demand is uncertain and 
may vary between periods. The company must determine which warehouse(s) to open and how to allocate 
demand in each period to minimise total costs, including both fixed and transportation costs.

Potential Demand Changes (Period 2)

• Scenario 1: Market X increases by 10%, Y decreases by 20%, Z remains constant.

• Scenario 2: Market X decreases by 15%, Y increases by 25%, Z increases by 10%.

Warehouse Market X Market Y Market Z Fixed Cost ($) Capacity (tonnes)

A 200 300 100 50,000 60

B 250 150 200 40,000 50

Period 1 Demand 30 40 20

Table 1. Capacity, demand and transportation cost 
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Objective Function (with Piecewise Cost)

min 𝑍 = min ෍

𝑗∈𝐽

෍

𝑘∈𝐾

𝐶𝑗𝑘 + ෍

𝑗∈𝐽

𝑓𝑗𝑧𝑗

Minimise total cost

where

• 𝑓𝑗: fixed cost for opening warehouse 𝑗

• 𝑧𝑗 ∈ 0, 1 : binary variable; 1 if warehouse 𝑗 is open

• 𝐶𝑗𝑘: cost of serving market 𝑘 from warehouse 𝑗, defined as:

𝐶𝑗𝑘 = ൝
𝑓𝑗𝑘

′ + 𝑔𝑗𝑘
′ ⋅ 𝑦𝑗𝑘 , if 𝑦𝑗𝑘 ≤ 𝑑𝑏,

𝑓𝑗𝑘
′′ + 𝑔𝑗𝑘

′′ ⋅ 𝑦𝑗𝑘 , if 𝑦𝑗𝑘 > 𝑑𝑏,

• 𝑤𝑗𝑘 ∈ 0, 1 : binary variable indicating which piece of the cost function is active: 

𝑤𝑗𝑘 = 0 → lower segment is active (i.e. 𝑦𝑗𝑘 ≤ 𝑑𝑏)
𝑤𝑗𝑘 = 1 → upper segment is active (i.e. 𝑦𝑗𝑘 > 𝑑𝑏) 
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Constraints

1. Demand satisfaction (Single sourcing)
෍

𝑗∈𝐽

𝑥𝑗𝑘 = 1, ∀𝑘 ∈ 𝐾, 𝑦𝑗𝑘 = 𝐷𝑘 ⋅ 𝑥𝑗𝑘 , ∀𝑗 ∈ 𝐽, 𝑘 ∈ 𝐾

2. Facility capacity constraints ෍

𝑘∈𝐾

𝑦𝑗𝑘 ≤ 𝐾𝑗𝑧𝑗 ,  ∀𝑗 ∈ 𝐽

Facility opening constraints 𝑥𝑗𝑘 ≤ 𝑧𝑗 , ∀𝑗 ∈ 𝐽, 𝑘 ∈ 𝐾

4. Binary capacity constraints

5. Non-negativity constraints

𝑧𝑗 , 𝑥𝑗𝑘 , 𝑤𝑗𝑘 ∈ 0, 1 , ∀𝑗 ∈ 𝐽, 𝑘 ∈ 𝐾

𝑦𝑗𝑘 ≥ 0, ∀𝑗 ∈ 𝐽, 𝑘 ∈ 𝐾

3. Piecewise cost approximation (Big-M Form)

𝐶𝑗𝑘 ≥ 𝑓𝑗𝑘
′ + 𝑔𝑗𝑘

′ ⋅ 𝑦𝑗𝑘 − 𝑀𝑤𝑗𝑘

𝐶𝑗𝑘 ≥ 𝑓𝑗𝑘
′′ + 𝑔𝑗𝑘

′′ ⋅ 𝑦𝑗𝑘 − 𝑀(1 − 𝑤𝑗𝑘)

𝑦𝑗𝑘 ≥ 𝑑𝑏 + 𝜖 − 𝑀(1 − 𝑤𝑗𝑘)

𝑦𝑗𝑘 ≤ 𝑑𝑏 + 𝑀𝑤𝑗𝑘

Lower segment constraint

Upper segment constraint

Breakpoint enforcement from below

Breakpoint enforcement from above
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Piecewise cost approximation (Big-M Form) explain 

𝐶𝑗𝑘 ≥ 𝑓𝑗𝑘
′ + 𝑔𝑗𝑘

′ ⋅ 𝑦𝑗𝑘 − 𝑀𝑤𝑗𝑘

𝑦𝑗𝑘 ≥ 𝑑𝑏 + 𝜖 − 𝑀(1 − 𝑤𝑗𝑘)

Lower segment constraint

Breakpoint enforcement from above

• When 𝑤𝑗𝑘 = 0, this become 𝐶𝑗𝑘 ≥ 𝑓𝑗𝑘
′ + 𝑔𝑗𝑘

′ ⋅ 𝑦𝑗𝑘 → active lower piece 

• When 𝑤𝑗𝑘 = 1, subtracting big M allows this constraint to be trivially satisfied → inactive

Big M is a large positive constant used in MILP to enable or disable constraints depending on the value of a binary variable (like 0 or 1).

• When 𝑤𝑗𝑘 = 1, this become 𝑦𝑗𝑘 ≥ 𝑑𝑏 + 𝜖, where 𝜖 is a tiny number to ensure separation

• When 𝑤𝑗𝑘 = 0, RHS becomes large negative → always holds.

Exercise: interpret the upper segment constraint and breakpoint enforcement from below.
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